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The Fuel Tank MKII BoosterPack™ plug-in module is the next generation design of the original Fuel Tank
BoosterPack plug-in module. The Fuel Tank MKII BoosterPack plug-in module includes next-generation TI
battery monitoring ICs and other new features to make it easier to use. The Fuel Tank MKII BoosterPack
plug-in module allows TI LaunchPad™ development kits to be powered from the included rechargeable
lithium polymer battery, further enabling mobile application development and evaluation.

Figure 1. BOOSTXL-BATPAKMKII Fuel Tank MKII Battery BoosterPack Plug-in Module
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Trademarks
BoosterPack, LaunchPad, Impedance Track, MSP432, Code Composer Studio, E2E are trademarks of
Texas Instruments.
Keil, µVision are registered trademarks of ARM Limited.
IAR Embedded Workbench is a registered trademark of IAR Systems.
All other trademarks are the property of their respective owners.

1 Getting Started

1.1 Introduction
The Fuel Tank MKII BoosterPack plug-in module is the next generation design of the original Fuel Tank
BoosterPack plug-in module. This BoosterPack plug-in module includes next-generation TI battery
monitoring ICs and other new features to make it easier to use. The Fuel Tank MKII BoosterPack plug-in
module module allows TI LaunchPad™ development kits to be powered from the included rechargeable
lithium polymer battery, further enabling mobile application development and evaluation.

The Fuel Tank MKII BoosterPack plug-in module includes an onboard lithium polymer battery charger and
gas gauge that provide critical parameters of the battery, including temperature, charging state, capacity,
and more. The BoosterPack plug-in module module comes with a lithium polymer battery cell, which can
be disconnected by a switch and charged through an onboard micro USB connector.

1.2 Key Features
• 3.7-V 1200-mAh lithium polymer battery
• Onboard bq27441 fuel (gas) gauge
• Onboard bq24250 lithium polymer charger
• USB charging with indicator LED
• Works with TI LaunchPad development kits

1.3 What's Included

1.3.1 Kit Contents
• 1 x BOOSTXL-BATPAKMKII BoosterPack plug-in module
• 1 x AE503759P6HA Li-Polymer rechargeable battery
• 1 x Quick Start Guide

1.3.2 Software Examples
• MSP-EXP432P401R + BOOSTXL-BATPAKMKII demo (see Section 3)

1.4 Next Steps: Looking Into the Provided Code
After the EVM features have been explored, the fun can begin. It's time to open an integrated
development environment (IDE) and start looking at the code examples. Section 3 describes the example
projects available to make it easy to understand the provided software.
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2 Hardware
Figure 2 shows an overview of the BOOSTXL-BATPAKMKII.

Figure 2. BOOSTXL-BATPAKMKII Overview

2.1 Hardware Features

2.1.1 BoosterPack Plug-in Module Pinout
Figure 3 shows the pinout of the BOOSTXL-BATPAKMKII.

Figure 3. BoosterPack Plug-in Module Pinout
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The Fuel Tank MKII BoosterPack plug-in module adheres to the 40-pin LaunchPad development kit and
BoosterPack plug-in module pinout standard. This standard was created to aid compatibility between
LaunchPad development kits and BoosterPack plug-in modules across the TI ecosystem.

The 40-pin standard followed by the BOOSTXL-BATPAKMKII is compatible with the 20-pin standard that
is used by other LaunchPad development kits like the MSP-EXP430G2 LaunchPad development kit. This
allows for 40-pin BoosterPack plug-in modules to be used with 20-pin LaunchPad development kits.

The BOOSTXL-BATPAKMKII BoosterPack plug-in module has male and female headers to support
stacking on top or bottom.

More information about compatibility can also be found at http://www.ti.com/launchpad.

2.1.2 TI BQ27441-G1 Fuel Gauge (Gas Gauge)
The bq27441-G1 fuel gauge is a microcontroller peripheral that provides system-side fuel gauging for
single-cell Li-Ion batteries. The device requires minimal user configuration and system microcontroller
firmware development.

The bq27441-G1 battery fuel gauge uses the patented Impedance Track™ technology for fuel gauging
and provides information such as remaining battery capacity (mAh), state of charge (%), and battery
voltage (mV).

The digital output is reported over an I2C 2-wire serial interface. The reference designator for the bq27441-
G1 is U1, with I2C 8-bit addresses 0xAA and 0xAB for write and read, respectively (0x55, 7-bit address).

More information on the bq27441-G1 fuel gauge can be found at http://www.ti.com/product/bq27441-g1
and in the bq27441-G1 technical reference manual. Table 1 lists the pin connections for the bq27441‑G1.

(1) Pin is multiplexed with the I2C communication lines of the bq27441-G1 and bq24250

Table 1. BQ27441-G1 Pinout

BoosterPack Plug-in Module Header Connection Pin Function
J1.9 (1) I2C SCL
J1.10 (1) I2C SDA
J4.40 BIN

The BIN pin detects when a battery is present. A jumper JP6 is available to simulate battery connect or
disconnect with the BoosterPack plug-in module hardware (J6 shorted = battery inserted; J6 open =
battery removed). Additionally, switch S1 can be used to fully disconnect the battery. The MCU device on
the LaunchPad development kit can monitor the BIN pin through the BoosterPack plug-in module header
when using hardware to control this pin. To enable BIN detection or control on the BoosterPack plug-in
module header, resistor R27 must be populated with 0 Ω (shorted).

The BIN hardware signal can be bypassed by the MCU software by using the BIE (Batter Insert Enable)
bit in the fuel gauge operation configuration register. When BIE is cleared, the battery detection relies on
the host to issue a BAT_INSERT subcommand to indicate battery presence, bypassing the J6 BIN jumper.
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2.1.3 TI BQ24250 Lithium-Ion Battery Charger
The bq24250 is a highly integrated single-cell Li-Ion battery chargers and system power-path
management devices targeted for space-limited portable applications with high-capacity batteries. The
single-cell charger has a single input that operates from either a USB port or an AC wall adapter for a
versatile solution.

The digital output is reported over an I2C two-wire serial interface. The reference designator for the
bq24250 is U2, with I2C address 0x6A (7-bit address).

More information on the bq24250 charger can be found at http://www.ti.com/product/bq24250. Table 2
lists the pin connections for the bq24250.

(1) Pin is multiplexed with the I2C communication lines of the bq27441-G1 and bq24250

Table 2. BQ24250 Pinout

BoosterPack Plug-in Module Header Connection Pin Function
J1.9 (1) I2C SCL
J1.10 (1) I2C SDA
J4.39 INT
J4.38 Charge
J4.36 EN2
J4.35 EN1
J4.34 CE

The CHG pin represents charge status as indicated by the LED. The LED is great for checking visually
that the battery is charging, but the CHG pin is also brought to the BoosterPack plug-in module header for
the MCU to check in a battery application. CHG pin is high impedance (LED off) when the battery is not
charging, and low (LED on) when the battery is charging. The CHG pin does not indicate recharge cycles.

The INT pin is similar to the CHG pin, but there are a few differences. INT represents the charging status
and fault interrupts. It is recommended to connect INT through an internal MCU pullup to properly read the
signal. When charging, INT is pulled low. When charging is complete (or charger disabled), INT will
change to high impedance. When used with a pullup resistor this can be read as high. INT delivers an
interrupt pulse when a fault is detected, and it also does indicate recharge cycles.

The CE pin is active-low charge enable. When CE is low the charger is enabled. Setting this pin high with
the MCU disables the charger.

The EN1 and EN2 pins set the input current limitations of the charger. By default they are set to input
current limit = 1 A and VIN_DPM = 4.36 V. These can be changed (along with other corresponding hardware)
to set the desired limits for these pins. See the device data sheet for more information.

2.1.4 3.7-V 1200-mAh Lithium-Polymer Battery
The battery featured on the Fuel Tank MKII BoosterPack plug-in module is AEenergy, type 503759, part
number AE503759P6HA. It is a Li-Polymer rechargeable battery rated at 3.7 V and 1200 mAh. Table 3 is
an overview of the battery specifications.

Table 3. Battery Specifications

Description Specification
Nominal Capacity 1200 mAh (typical)
Nominal Voltage 3.7 V
Charging Voltage 4.20 ±0.05 V
Max Charging Current 1100 mA
Max Continuous Discharge Current 2200 mA
Discharge Cutoff Voltage 2.75 V
Battery Dimensions 37 mm × 60 mm × 5 mm
Battery Weight 24 ±2.0 g

http://www.ti.com
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2.1.5 Switch S1
Switch S1 is a mechanical switch that fully disconnects the battery from the onboard circuitry. The original
Fuel Tank BoosterPack plug-in module had no switch and required the user to disconnect the battery from
the connector on the BoosterPack plug-in module to prevent the battery from draining.

The Fuel Tank MKII BoosterPack plug-in module features this switch as an easy way to fully disconnect
the battery to prevent discharge when not in use, or to power off the system during use.

2.2 Power
The Fuel Tank BoosterPack plug-in module MKII was designed to power TI LaunchPad development kits
for applications that cannot be connected to USB power. More details on the power system behavior are
below.

2.2.1 LaunchPad Development Kit 3V3 and 5V rails
The 3V3 (J1.1) and 5V (J3.21) rails to power the LaunchPad development kit are derived from two buck-
boost converters on the BOOSTXL-BATPAKMKII.

2.2.1.1 TI TPS63001 3.3-V Buck-Boost DC-DC Converter
The TPS63001 provides a regulated 3.3-V power rail (J1.1) on the LaunchPad development kit. This 3V3
rail has a maximum current output limit of 1200 mA.

The input to the TPS63001 is the PAK+_OUT signal directly from the battery. Because of the direct
battery connection, configuration of the fuel gauge and Li-Ion charger are irrelevant to this voltage output.
The buck-boost converter is able to provide the regulated 3.3 V across the full range of the battery from
4.2 V down to 2.8 V. The buck-boost converters are disabled when the BAT_LOW signal is asserted by
the fuel gauge. This BAT_LOW signal is directly tied to the EN pin of the buck-boost converter to disable
any voltage output when the battery is critically low.

The TPS63001 has a power save mode of operation that uses less quiescent current, but provides a
slightly less stable voltage rail. To enable this feature, the PS pin needs to be pulled low. This can be
done by removing R18 and populating R17.

2.2.1.2 TI TPS63002 5-V Buck-Boost DC-DC Converter
The TPS63002 provides a regulated 5-V power rail (J3.21) on the LaunchPad development kit. This 5V
rail has a maximum current output limit of 800 mA.

The input to the TPS63002 is the PAK+_OUT signal directly from the battery. Because of the direct
battery connection, configuration of the fuel gauge and Li-Ion charger are irrelevant to this voltage output.
The buck-boost converter is able to provide the regulated 5V across the full range of the battery from
4.2 V down to 2.8 V. The buck-boost converters are disabled when the BAT_LOW signal is asserted by
the fuel gauge. This BAT_LOW signal is directly tied to the EN pin of the buck-boost converter to disable
any voltage output when the battery is critically low.

The TPS63002 has a power save mode of operation that uses less quiescent current, but provides a
slightly less stable voltage rail. To enable this feature, the PS pin needs to be pulled low. This can be
done by removing R20 and populating R19.

2.2.1.3 BQ24250 DC-DC SYS Output
The bq24250 Li-Ion battery charger provides its own regulated DC-DC output on the SYS pin. In many
applications this output is used to provide system power. On the Fuel Tank MKII BoosterPack plug-in
module, this output is placed onto a test point for access (TP4), but not explicitly used to power the
connected LaunchPad development kit.

http://www.ti.com
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2.2.2 Charging the Battery
The battery is charged by the USB connector on the Fuel Tank MKII BoosterPack plug-in module. 5V
through the USB connection on the Fuel Tank MKII BoosterPack plug-in module or connected to TP1 is
the only way to charge the battery.

NOTE: Connecting USB directly to a LaunchPad development kit that is plugged into the Fuel Tank
MKII BoosterPack plug-in module does not charge the battery.

The charging LED (LED2) indicates if a charge is active or not. This provides a quick visual check that the
battery is charging, and also alerts the user when the battery has finished charging.

NOTE: The tolerance of the resistors populated at R15 and R16 can cause the voltage on the TS
pin to go above the VCOLD threshold, which disables charging. If the battery is not charging as
expected and R9 is not populated, decrease the resistance of R16 to 5.1 kΩ or populate R9
with a 10-kΩ resistor to put the TS voltage between the VCOOL and VWARM thresholds.

2.2.3 Using the Fuel Tank MKII BoosterPack Plug-in Module and LaunchPad Development Kit PC
Connection

In certain situations, users may wish to connect the Fuel Tank MKII BoosterPack plug-in module to the
LaunchPad development kit, while the LaunchPad development kit communicates with a PC. The MSP-
EXP432P401R software example is a good example of this use case.

When this setup is needed, it is important to disconnect the power rails on the LaunchPad development kit
from its own USB connection, so that there is not a power rail conflict with the on-LaunchPad development
kit voltage and the Fuel Tank MKII BoosterPack plug-in module. To do this, the 3V3 and 5V jumpers that
connect the LaunchPad development kit target side to the debugger must be removed. The debugger still
receives power from the USB connection, and the target side will receive power from the Fuel Tank MKII
BoosterPack plug-in module. Figure 4 shows an example on the MSP-EXP432P401R LaunchPad
development kit.

http://www.ti.com
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Figure 4. LaunchPad Development Kit Jumper Removal With USB Connection

2.3 Design Files

2.3.1 Hardware
Section 5 shows the schematics. All design files including schematics, layout, bill of materials (BOM),
Gerber files, and documentation are available on the BOOSTXL-BATPAKMKII Hardware Design Files on
the download page.

2.3.2 Software
All design files including TI-TXT object-code firmware images, software example projects, and
documentation are available in the LaunchPad development kit specific software folders. To see which
LaunchPad development kits feature BOOSTXL-BATPAKMKII examples, visit the download page.

2.3.3 Quick Start Guide
A Quick Start Guide is also available.

2.4 Hardware Change log
Table 4 lists the revision history of the BOOSTXL-BATPAKMKII hardware.

Table 4. Hardware Change Log

PCB Revision Description
Rev 1.0 Initial release
Rev 1.1 CE EMC compliance and updates to Charger TS pin circuit

http://www.ti.com
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3 Software Examples
One software example is included with the MSP-EXP432P401R LaunchPad development kit for the
Battery BoosterPack plug-in module (see Table 5). This example can be found in the MSP-EXP432P401R
Software Examples zip folder.

Table 5. Software Examples

Demo name LaunchPad / BoosterPack
Required Description More Details

BOOSTXL-BATPAKMKII_
FuelGauge_MSP432P401R

MSP-EXP432P401R /
BOOSTXL-BATPAKMKII

Demonstrates how to initialize bq27441-G1 fuel
gauge configurations and how to control and
read data registers

Section 3.1

To use any of the software examples with the LaunchPad development kit, you must have an integrated
development environment (IDE) that supports the MSP432P401R device (see Table 6).

Table 6. IDE Minimum Requirements for MSP-EXP432P401R

Code Composer Studio™ IDE IAR Embedded Workbench® IDE Keil® µVision® IDE
CCS v6.1 or later IAR Embedded Workbench for ARM 7.40 or later Keil µVision MDK-ARM v5 or later

For more details on how to get started quickly, and where to download the latest CCS, IAR, and Keil IDEs,
see Section 4.

3.1 BOOSTXL-BATPAKMKII_FuelGauge_MSP432P401R
This section describes the functionality and structure of the BOOSTXL-
BATPAKMKII_FuelGauge_MSP432P401R demo that is included in the MSP-EXP432P401R Software
Examples download, or more easily accessible through MSPWare (see Section 4.2).

3.1.1 Source File Structure
The project is split into multiple files (see Table 7). This makes it easier to navigate and reuse parts of it
for other projects.

Table 7. Source File and Folders

Name Description
Library: driverlib Device driver library (MSP432DRIVERLIB)
startup_msp432p401r.c MSP432™ MCU family interrupt vector table for CGT
HAL_BQ27441.c Driver for communicating with the bq27441-G1 fuel gauge
HAL_I2C.c Board specific support driver for I2C communication
HAL_UART.c Board specific driver for UART communication through Application/User UART
main.c The main function of the demo, global variables, and more

3.1.2 Running the Fuel Gauge Example
After the compiling/loading the BOOSTXL-BATPAKMKII_FuelGauge_MSP432P401R project or
downloading the pre-built firmware binary onto the MSP-EXP432P401R LaunchPad development kit,
included in the MSP-EXP432P401R Software Examples, follow the steps below to run the demo firmware.

http://www.ti.com
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Figure 5. Hardware Setup and Connections

1. Attach the BOOSTXL-BATPAKMKII Battery BoosterPack plug-in module to the LaunchPad
development kit.

2. Flip the switch to the "ON" position on the side of the BOOSTXL-BATPAKMKII Battery BoosterPack
plug-in module.

3. Connect the MSP-EXP432P401R LaunchPad development kit to a computer via micro-USB cable.
4. Launch a serial terminal application and connect to the COM port for "XDS110 Class Application/User

UART" at 115200 baud rate (see Figure 6 and Figure 7).

Figure 6. Determine COM Port Number Using Device Manager on Windows

Figure 7. Example Serial Terminal Configuration

5. Press the reset button on the MSP-EXP432P401R LaunchPad development kit.

http://www.ti.com
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6. Observe serial data displaying Fuel Gauge configuration and Battery Information.

Figure 8. Snapshot of Serial Terminal Connected to Running Fuel Gauge Demo

http://www.ti.com
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3.1.3 Firmware Overview
Refer to Quick Start Guide for bq27441-G1 and bq27441-G1 Technical Reference Manual for detailed
description of the Battery Fuel Gauge usage.

The demo program begins by initializing a number of configuration parameters in the bq27441-G1 to
match the target battery. Four important parameters are Design Capacity, Design Energy, Terminate
Voltage, and Taper Rate. Values are determined based on the target battery properties and bq27441-G1
documentations.

Next, the host MSP432P401R MCU clears the BIE (Batter Insert Enable) bit in the fuel gauge operation
configuration register. When BIE is cleared, the battery detection will rely on the host to issue a
BAT_INSERT subcommand to indicate battery presence, bypassing the J6 BIN jumper on the BOOSTXL-
BATPAKMKII BoosterPack plug-in module that the fuel gauge relies on for battery detection by default
when BIE is set (J6 shorted = Battery Inserted; J6 open = Battery Removed). This is done to ensure the
demo application works regardless if J6 is connected or not.

In end user applications, a switch or the host MCU would more likely be used control the BIN state of the
fuel gauge depending on battery connection. However, this is not implemented on the BoosterPack plug-in
module and a jumper is used to manually toggle between battery insertion and removal.

Once the bq27441-G1 has been configured properly, the main loop repeatedly reads back
DESIGN_CAPACITY, REMAINING_CAPACITY, STATE_OF_CHARGE, TEMPERATURE, VOLTAGE,
and AVERAGE_CURRENT from the fuel gauge. Results are formatted and transmitted through
Application/User UART.

4 Additional Resources

4.1 TI LaunchPad™ Development Kit Portal
More information about LaunchPad development kits, supported BoosterPack plug-in modules, and
available resources can be found at:
• TI's LaunchPad portal: information about all LaunchPad development kits from TI, for all

microcontrollers

4.2 TI Cloud Development Tools
TI's Cloud-based software development tools provide instant access to MSPWare software content and a
web-based IDE.

http://www.ti.com
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http://www.ti.com/launchpad
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4.2.1 TI Resource Explorer Cloud
TI Resource Explorer Cloud provides a web interface for browsing examples, libraries and documentation
found in the MSPWare software without having to download files to your local drive (see Figure 9).

Learn more about TI Resource Explorer Cloud now at https://dev.ti.com/.

Figure 9. TI Resource Explorer Cloud

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU618A
https://dev.ti.com/
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4.2.2 Code Composer Studio™ Cloud
Code Composer Studio™ Cloud (CCS Cloud) is a web-based IDE that enables you to quickly create, edit,
build and debug applications for your LaunchPad development kit. No need to download and install large
software packages, simply connect your LaunchPad development kit and begin. You can choose to select
from a large variety of examples in MSPWare software and Energia or develop your own application. CCS
Cloud IDE supports debug features such as execution control, breakpoints and viewing variables.

A full comparison between CCS IDE Cloud and CCS Desktop is available here.

Learn more about Code Composer Studio Cloud IDE now at https://dev.ti.com/.

Figure 10. CCS Cloud

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU618A
https://dev.ti.com/about#cloudordesktop
https://dev.ti.com/
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4.3 Code Composer Studio™ IDE
Code Composer Studio (CCS) IDE Desktop is a professional integrated development environment that
supports TI's microcontroller and Embedded Processors portfolio. Code Composer Studio IDE comprises
a suite of tools used to develop and debug embedded applications. It includes an optimizing C/C++
compiler, source code editor, project build environment, debugger, profiler, and many other features.

Learn more about CCS IDE and download it at http://www.ti.com/tool/ccstudio.

CCS IDE v6.1 or higher is required. When CCS has been launched, and a workspace directory chosen,
use Project → Import Existing CCS Eclipse Project. Direct it to the desired demo project directory that
contains main.c.

Figure 11. Directing the Project → Import Function to the Demo Project

Selecting the \CCS subdirectory also works. The CCS-specific files are located there.

When you click OK, CCS should recognize the project and allow you to import it. The indication that CCS
has found it is that the project appears in the box shown in 12, and it has a checkmark to the left of it (see
Figure 12).

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU618A
http://www.ti.com/tool/ccstudio
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Figure 12. When CCS Has Found the Project

Sometimes CCS IDE finds the project but does not show a checkmark; this might mean that your
workspace already has a project by that name. You can resolve this by renaming or deleting that project.
(Even if you do not see it in the CCS IDE workspace, be sure to check the workspace directory on the file
system.)

4.4 IAR Embedded Workbench® for Texas Instruments MSP430 MCUs
IAR Embedded Workbench for MSP430 MCUs is another very powerful integrated development
environment that allows you to develop and manage complete embedded application projects. It integrates
the IAR C/C++ Compiler, IAR Assembler, IAR ILINK Linker, editor, project manager, command line build
utility, and IAR C-SPY® Debugger.

You can learn more about IAR Embedded Workbench for MSP430 and download it at
http://supp.iar.com/Download/SW/?item=EW430-EVAL.

IAR 6.10 or higher is required. To open the demo in IAR, click File → Open → Workspace…, and browse
to the *.eww workspace file inside the \IAR subdirectory of the desired demo. All workspace information is
contained within this file.

The subdirectory also has an *.ewp project file. This file can be opened into an existing workspace by
clicking Project → Add-Existing-Project….

Although the software examples have all of the code required to run them, IAR users may download and
install MSPWare software, which contains MSP430 MCU libraries and the TI Resource Explorer. These
are already included in a Code Composer Studio installation (unless the user selected otherwise).

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU618A
http://supp.iar.com/Download/SW/?item=EW430-EVAL
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4.5 Energia
Energia is a simple, open-source, and community-driven code editor that is based on the Wiring and
Arduino framework. Energia provides unmatched ease of use through very high-level APIs that can be
used across hardware platforms. Energia is a light-weight IDE that does not have the full feature set of
Code Composer Studio IDE or IAR. However, Energia is great for anyone who wants to get started very
quickly or who does not have significant coding experience.

You can learn more about Energia and download it at www.energia.nu.

4.6 MSPWare Software and TI Resource Explorer
MSPWare software is a complete collection of libraries and tools. It includes a driver library (driverlib),
graphics library (grlib), and many other software tools. MSPWare software is optionally included in a Code
Composer Studio installation or can be downloaded separately. IAR users must download it separately.

MSPWare software includes the TI Resource Explorer, for easily browsing tools (see Figure 13). For
example, all the software examples are shown in the tree.

Figure 13. Software Examples in TI Resource Explorer

Inside TI Resource Explorer, these examples and many more can be found, and easily imported into Code
Composer Studio IDE with one click.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU618A
http://wiring.org.co/
http://arduino.cc/
http://www.energia.nu/
http://www.ti.com/tool/msp430ware
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4.7 The Community

4.7.1 TI E2E™ Online Community
Search the forums at http://e2e.ti.com. If you cannot find your answer, post your question to the
community.

4.7.2 Community at Large
Many online communities focus on the LaunchPad development kit and BoosterPack plug-in module
ecosystem; for example, http://www.43oh.com. You can find additional tools, resources, and support from
these communities.

5 Schematics
Hardware design files can be found at BOOSTXL-BATPAKMKII Hardware Design Files.

Figure 14 shows the schematic.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU618A
http://e2e.ti.com/
http://www.43oh.com/
http://software-dl.ti.com/msp430/msp430_public_sw/mcu/msp430/BOOSTXL-BATPAKMKII/latest/index_FDS.html
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Figure 14. Schematics

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU618A
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STANDARD TERMS FOR EVALUATION MODULES
1. Delivery: TI delivers TI evaluation boards, kits, or modules, including any accompanying demonstration software, components, and/or

documentation which may be provided together or separately (collectively, an “EVM” or “EVMs”) to the User (“User”) in accordance
with the terms set forth herein. User's acceptance of the EVM is expressly subject to the following terms.
1.1 EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility

evaluation, experimentation, or scientific analysis of TI semiconductors products. EVMs have no direct function and are not
finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For
clarification, any software or software tools provided with the EVM (“Software”) shall not be subject to the terms and conditions
set forth herein but rather shall be subject to the applicable terms that accompany such Software

1.2 EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned,
or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production
system.

2 Limited Warranty and Related Remedies/Disclaimers:
2.1 These terms do not apply to Software. The warranty, if any, for Software is covered in the applicable Software License

Agreement.
2.2 TI warrants that the TI EVM will conform to TI's published specifications for ninety (90) days after the date TI delivers such EVM

to User. Notwithstanding the foregoing, TI shall not be liable for a nonconforming EVM if (a) the nonconformity was caused by
neglect, misuse or mistreatment by an entity other than TI, including improper installation or testing, or for any EVMs that have
been altered or modified in any way by an entity other than TI, (b) the nonconformity resulted from User's design, specifications
or instructions for such EVMs or improper system design, or (c) User has not paid on time. Testing and other quality control
techniques are used to the extent TI deems necessary. TI does not test all parameters of each EVM.
User's claims against TI under this Section 2 are void if User fails to notify TI of any apparent defects in the EVMs within ten (10)
business days after delivery, or of any hidden defects with ten (10) business days after the defect has been detected.

2.3 TI's sole liability shall be at its option to repair or replace EVMs that fail to conform to the warranty set forth above, or credit
User's account for such EVM. TI's liability under this warranty shall be limited to EVMs that are returned during the warranty
period to the address designated by TI and that are determined by TI not to conform to such warranty. If TI elects to repair or
replace such EVM, TI shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall be
warranted for the remainder of the original warranty period. Replaced EVMs shall be warranted for a new full ninety (90) day
warranty period.

3 Regulatory Notices:
3.1 United States

3.1.1 Notice applicable to EVMs not FCC-Approved:
FCC NOTICE: This kit is designed to allow product developers to evaluate electronic components, circuitry, or software
associated with the kit to determine whether to incorporate such items in a finished product and software developers to write
software applications for use with the end product. This kit is not a finished product and when assembled may not be resold or
otherwise marketed unless all required FCC equipment authorizations are first obtained. Operation is subject to the condition
that this product not cause harmful interference to licensed radio stations and that this product accept harmful interference.
Unless the assembled kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must
operate under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this chapter.
3.1.2 For EVMs annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:

CAUTION
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.
Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to
operate the equipment.

FCC Interference Statement for Class A EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to
correct the interference at his own expense.



FCC Interference Statement for Class B EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more
of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

3.2 Canada
3.2.1 For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210 or RSS-247

Concerning EVMs Including Radio Transmitters:
This device complies with Industry Canada license-exempt RSSs. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference that may
cause undesired operation of the device.

Concernant les EVMs avec appareils radio:
Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation
est autorisée aux deux conditions suivantes: (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit
accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Concerning EVMs Including Detachable Antennas:
Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser)
gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type
and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for
successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types
listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated.
Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited
for use with this device.

Concernant les EVMs avec antennes détachables
Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et
d'un gain maximal (ou inférieur) approuvé pour l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage
radioélectrique à l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope
rayonnée équivalente (p.i.r.e.) ne dépasse pas l'intensité nécessaire à l'établissement d'une communication satisfaisante. Le
présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le
manuel d’usage et ayant un gain admissible maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne
non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l'exploitation de
l'émetteur

3.3 Japan
3.3.1 Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page 日本国内に

輸入される評価用キット、ボードについては、次のところをご覧ください。
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page

3.3.2 Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan may not be certified
by TI as conforming to Technical Regulations of Radio Law of Japan.

If User uses EVMs in Japan, not certified to Technical Regulations of Radio Law of Japan, User is required to follow the
instructions set forth by Radio Law of Japan, which includes, but is not limited to, the instructions below with respect to EVMs
(which for the avoidance of doubt are stated strictly for convenience and should be verified by User):
1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal

Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for
Enforcement of Radio Law of Japan,

2. Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to
EVMs, or

3. Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan
with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note
that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.

http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page


【無線電波を送信する製品の開発キットをお使いになる際の注意事項】 開発キットの中には技術基準適合証明を受けて
いないものがあります。 技術適合証明を受けていないもののご使用に際しては、電波法遵守のため、以下のいずれかの
措置を取っていただく必要がありますのでご注意ください。
1. 電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備でご使用

いただく。
2. 実験局の免許を取得後ご使用いただく。
3. 技術基準適合証明を取得後ご使用いただく。

なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします。
上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。 日本テキサス・イ

ンスツルメンツ株式会社
東京都新宿区西新宿６丁目２４番１号
西新宿三井ビル

3.3.3 Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
電力線搬送波通信についての開発キットをお使いになる際の注意事項については、次のところをご覧ください。http:/
/www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page

3.4 European Union
3.4.1 For EVMs subject to EU Directive 2014/30/EU (Electromagnetic Compatibility Directive):

This is a class A product intended for use in environments other than domestic environments that are connected to a
low-voltage power-supply network that supplies buildings used for domestic purposes. In a domestic environment this
product may cause radio interference in which case the user may be required to take adequate measures.

4 EVM Use Restrictions and Warnings:
4.1 EVMS ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT

LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.
4.2 User must read and apply the user guide and other available documentation provided by TI regarding the EVM prior to handling

or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information
related to, for example, temperatures and voltages.

4.3 Safety-Related Warnings and Restrictions:
4.3.1 User shall operate the EVM within TI’s recommended specifications and environmental considerations stated in the user

guide, other available documentation provided by TI, and any other applicable requirements and employ reasonable and
customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input
and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or
property damage. If there are questions concerning performance ratings and specifications, User should contact a TI
field representative prior to connecting interface electronics including input power and intended loads. Any loads applied
outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible
permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any
load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field representative.
During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit
components may have elevated case temperatures. These components include but are not limited to linear regulators,
switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the
information in the associated documentation. When working with the EVM, please be aware that the EVM may become
very warm.

4.3.2 EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the
dangers and application risks associated with handling electrical mechanical components, systems, and subsystems.
User assumes all responsibility and liability for proper and safe handling and use of the EVM by User or its employees,
affiliates, contractors or designees. User assumes all responsibility and liability to ensure that any interfaces (electronic
and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely
limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and
liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or
designees.

4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal,
state, or local laws and regulations related to User’s handling and use of the EVM and, if applicable, User assumes all
responsibility and liability for compliance in all respects with such laws and regulations. User assumes all responsibility and
liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local
requirements.

5. Accuracy of Information: To the extent TI provides information on the availability and function of EVMs, TI attempts to be as accurate
as possible. However, TI does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as
accurate, complete, reliable, current, or error-free.

http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page


6. Disclaimers:
6.1 EXCEPT AS SET FORTH ABOVE, EVMS AND ANY MATERIALS PROVIDED WITH THE EVM (INCLUDING, BUT NOT

LIMITED TO, REFERENCE DESIGNS AND THE DESIGN OF THE EVM ITSELF) ARE PROVIDED "AS IS" AND "WITH ALL
FAULTS." TI DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT
NOT LIMITED TO ANY EPIDEMIC FAILURE WARRANTY OR IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE
SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.

6.2 EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN, NOTHING IN THESE TERMS SHALL BE
CONSTRUED AS GRANTING OR CONFERRING ANY RIGHTS BY LICENSE, PATENT, OR ANY OTHER INDUSTRIAL OR
INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSORS OR ANY OTHER THIRD PARTY, TO USE THE
EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY INVENTION, DISCOVERY OR
IMPROVEMENT, REGARDLESS OF WHEN MADE, CONCEIVED OR ACQUIRED.

7. USER'S INDEMNITY OBLIGATIONS AND REPRESENTATIONS. USER WILL DEFEND, INDEMNIFY AND HOLD TI, ITS
LICENSORS AND THEIR REPRESENTATIVES HARMLESS FROM AND AGAINST ANY AND ALL CLAIMS, DAMAGES, LOSSES,
EXPENSES, COSTS AND LIABILITIES (COLLECTIVELY, "CLAIMS") ARISING OUT OF OR IN CONNECTION WITH ANY
HANDLING OR USE OF THE EVM THAT IS NOT IN ACCORDANCE WITH THESE TERMS. THIS OBLIGATION SHALL APPLY
WHETHER CLAIMS ARISE UNDER STATUTE, REGULATION, OR THE LAW OF TORT, CONTRACT OR ANY OTHER LEGAL
THEORY, AND EVEN IF THE EVM FAILS TO PERFORM AS DESCRIBED OR EXPECTED.

8. Limitations on Damages and Liability:
8.1 General Limitations. IN NO EVENT SHALL TI BE LIABLE FOR ANY SPECIAL, COLLATERAL, INDIRECT, PUNITIVE,

INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THESE
TERMS OR THE USE OF THE EVMS , REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. EXCLUDED DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, COST OF REMOVAL OR
REINSTALLATION, ANCILLARY COSTS TO THE PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, RETESTING,
OUTSIDE COMPUTER TIME, LABOR COSTS, LOSS OF GOODWILL, LOSS OF PROFITS, LOSS OF SAVINGS, LOSS OF
USE, LOSS OF DATA, OR BUSINESS INTERRUPTION. NO CLAIM, SUIT OR ACTION SHALL BE BROUGHT AGAINST TI
MORE THAN TWELVE (12) MONTHS AFTER THE EVENT THAT GAVE RISE TO THE CAUSE OF ACTION HAS
OCCURRED.

8.2 Specific Limitations. IN NO EVENT SHALL TI'S AGGREGATE LIABILITY FROM ANY USE OF AN EVM PROVIDED
HEREUNDER, INCLUDING FROM ANY WARRANTY, INDEMITY OR OTHER OBLIGATION ARISING OUT OF OR IN
CONNECTION WITH THESE TERMS, , EXCEED THE TOTAL AMOUNT PAID TO TI BY USER FOR THE PARTICULAR
EVM(S) AT ISSUE DURING THE PRIOR TWELVE (12) MONTHS WITH RESPECT TO WHICH LOSSES OR DAMAGES ARE
CLAIMED. THE EXISTENCE OF MORE THAN ONE CLAIM SHALL NOT ENLARGE OR EXTEND THIS LIMIT.

9. Return Policy. Except as otherwise provided, TI does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s)
will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in
a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable
order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the components(s),
excluding any postage or packaging costs.

10. Governing Law: These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas,
without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to
these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas.
Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and TI may seek injunctive relief
in any United States or foreign court.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2018, Texas Instruments Incorporated



IMPORTANT NOTICE FOR TI DESIGN INFORMATION AND RESOURCES

Texas Instruments Incorporated (‘TI”) technical, application or other design advice, services or information, including, but not limited to,
reference designs and materials relating to evaluation modules, (collectively, “TI Resources”) are intended to assist designers who are
developing applications that incorporate TI products; by downloading, accessing or using any particular TI Resource in any way, you
(individually or, if you are acting on behalf of a company, your company) agree to use it solely for this purpose and subject to the terms of
this Notice.
TI’s provision of TI Resources does not expand or otherwise alter TI’s applicable published warranties or warranty disclaimers for TI
products, and no additional obligations or liabilities arise from TI providing such TI Resources. TI reserves the right to make corrections,
enhancements, improvements and other changes to its TI Resources.
You understand and agree that you remain responsible for using your independent analysis, evaluation and judgment in designing your
applications and that you have full and exclusive responsibility to assure the safety of your applications and compliance of your applications
(and of all TI products used in or for your applications) with all applicable regulations, laws and other applicable requirements. You
represent that, with respect to your applications, you have all the necessary expertise to create and implement safeguards that (1)
anticipate dangerous consequences of failures, (2) monitor failures and their consequences, and (3) lessen the likelihood of failures that
might cause harm and take appropriate actions. You agree that prior to using or distributing any applications that include TI products, you
will thoroughly test such applications and the functionality of such TI products as used in such applications. TI has not conducted any
testing other than that specifically described in the published documentation for a particular TI Resource.
You are authorized to use, copy and modify any individual TI Resource only in connection with the development of applications that include
the TI product(s) identified in such TI Resource. NO OTHER LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE TO
ANY OTHER TI INTELLECTUAL PROPERTY RIGHT, AND NO LICENSE TO ANY TECHNOLOGY OR INTELLECTUAL PROPERTY
RIGHT OF TI OR ANY THIRD PARTY IS GRANTED HEREIN, including but not limited to any patent right, copyright, mask work right, or
other intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information
regarding or referencing third-party products or services does not constitute a license to use such products or services, or a warranty or
endorsement thereof. Use of TI Resources may require a license from a third party under the patents or other intellectual property of the
third party, or a license from TI under the patents or other intellectual property of TI.
TI RESOURCES ARE PROVIDED “AS IS” AND WITH ALL FAULTS. TI DISCLAIMS ALL OTHER WARRANTIES OR
REPRESENTATIONS, EXPRESS OR IMPLIED, REGARDING TI RESOURCES OR USE THEREOF, INCLUDING BUT NOT LIMITED TO
ACCURACY OR COMPLETENESS, TITLE, ANY EPIDEMIC FAILURE WARRANTY AND ANY IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL
PROPERTY RIGHTS.
TI SHALL NOT BE LIABLE FOR AND SHALL NOT DEFEND OR INDEMNIFY YOU AGAINST ANY CLAIM, INCLUDING BUT NOT
LIMITED TO ANY INFRINGEMENT CLAIM THAT RELATES TO OR IS BASED ON ANY COMBINATION OF PRODUCTS EVEN IF
DESCRIBED IN TI RESOURCES OR OTHERWISE. IN NO EVENT SHALL TI BE LIABLE FOR ANY ACTUAL, DIRECT, SPECIAL,
COLLATERAL, INDIRECT, PUNITIVE, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES IN CONNECTION WITH OR
ARISING OUT OF TI RESOURCES OR USE THEREOF, AND REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.
You agree to fully indemnify TI and its representatives against any damages, costs, losses, and/or liabilities arising out of your non-
compliance with the terms and provisions of this Notice.
This Notice applies to TI Resources. Additional terms apply to the use and purchase of certain types of materials, TI products and services.
These include; without limitation, TI’s standard terms for semiconductor products http://www.ti.com/sc/docs/stdterms.htm), evaluation
modules, and samples (http://www.ti.com/sc/docs/sampterms.htm).
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